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CHAPTER 1

A B O U T  T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T
T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T
This chapter contains an overview of

TRADOS T-Window for PowerPoint. It

includes a user profile, system

requirements and installation

requirements, and provides a roadmap to

the other features found in the User Guide.
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1 In troduc t ion
I N T R O D U C T I O N
TRADOS T-Window for PowerPoint represents a unique new concept in the history of the TRADOS fine 
translation tool set. The T-Window is a translation environment which provides all the powerful 
language processing features of TRADOS Translator’s Workbench while also giving the translator full 
access to the formidable formatting features of Microsoft PowerPoint.

PowerPoint (PPT) presentations normally rely heavily on sophisticated formatting, so for a translation 
environment to be useful, the translator must be able to see what the impact of the translation on the 
text will do to the visual aspect of the segment.

Translation memory technology is an essential part of the professional translator’s tool kit and TRADOS 
Translator’s Workbench is widely recognised as the world leader in this field. Used by thousands of 
professional translators across the world, every day, in industry, education and wherever translation of 
technical reference material is taking place, TRADOS Translator’s Workbench provides the ultimate in 
state of the art translation memory technology.

TRADOS T-Window for PowerPoint is the only translation environment that allows the translator to fully 
access a translation memory database whilst working directly within PowerPoint.

ABOUT THIS USER GUIDE
Chapter 1 contains general information about getting started with TRADOS T-Window for PowerPoint. 
It includes system requirements and installation instructions. 

Chapter 2 includes a tutorial which will help you to explore the main features of TRADOS T-Window for 
PowerPoint immediately.

Chapter 3 explains some of the project management features of TRADOS T-Window for PowerPoint and 
guides you through the translation workflow recommended for translating PowerPoint presentations. 
It also includes a troubleshooting section.

➜
NOTE

This User Guide assumes that the user is familiar with the basic features of both PowerPoint 
and TRADOS Translator’s Workbench. For new users of TRADOS Translator’s Workbench, we 
recommend that you first work through the TRADOS T-Window for PowerPoint self-running 
demo which is available from the TRADOS Web site: http://www.trados.com.

TRADOS T-Window for PowerPoint provides context-sensitive on-line help which may be accessed at 
any time while translating. A TRADOS T-Window for PowerPoint Essentials Guide is also available from 
the TRADOS Web site: http://www.trados.com.

USER PROFILE
T-Window for PowerPoint is specifically aimed at translators who are translating PowerPoint 
presentations. Until now there was no way to effectively harness translation memory technology while 
translating directly in PowerPoint. TRADOS T-Window for PowerPoint is most useful where PowerPoint 
presentations which require translation are updated frequently. TRADOS T-Window for PowerPoint 
allows the translator to efficiently reuse previous translations through TRADOS Translator’s 
Workbench.
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1Syst em Requirements
S Y S T E M  R E Q U I R E M E N T S
The minimum specification to be able to run TRADOS T-Window for PowerPoint is a PC with a Pentium 
processor and at least 32 MB RAM. SVGA graphics card and mouse are strongly recommended.

PLATFORM INFORMATION
Windows 95, 98 and NT 4.0 with Service Pack 3 or later are supported.

Although TRADOS T-Window for PowerPoint is a Windows application, Microsoft PowerPoint 97 files 
from any platform supported by PowerPoint can be translated, so long as they are opened in 
PowerPoint 97 on a Windows platform. No distinction is made between them.

LANGUAGES SUPPORTED
Translation into all Western and Eastern European languages supported by PowerPoint are supported 
by T-Window for PowerPoint. 

TRADOS TRANSLATOR’S WORKBENCH VERSION
TRADOS T-Window for PowerPoint is a TRADOS Translator’s Workbench API application which is 
designed to run with version 2.2 or later of TRADOS Translator’s Workbench. If you are working with 
Version 2.0, download the latest release from the TRADOS Web site (http://www.trados.com). If you 
are working with a 1.x version of TRADOS Translator’s Workbench, contact your local TRADOS office 
to obtain an upgrade.

MICROSOFT POWERPOINT VERSION
TRADOS T-Window for PowerPoint requires Microsoft PowerPoint 97. If you are working with 
presentations which originated in an earlier version of PowerPoint, open and save them in 
PowerPoint 97 before proceeding with translation.

DONGLE PROTECTION
TRADOS T-Window for PowerPoint is copy protected. It uses a form of copy protection known as a 
dongle or security key. The dongle is a little device that you insert in the parallel port on your computer. 
TRADOS T-Window for PowerPoint will check that the dongle is attached. If the dongle is not attached, 
the application will run in demo mode only. Since TRADOS T-Window for PowerPoint can be used only 
in conjunction with TRADOS Translator's Workbench, the dongle ID number is added to your 
Translator's Workbench dongle. If you have an existing TRADOS Translator’s Workbench licence and 
you then purchase TRADOS T-Window for PowerPoint, you will need to upgrade your TRADOS 
Translator’s Workbench dongle so that it will also recognise T-Window.

Dongle Upgrade Procedure

If you have purchased TRADOS Translator’s Workbench and TRADOS T-Window for PowerPoint at the 
same time, you can ignore the following instructions as your dongle is already enabled for both 
products. 
T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T 1-3



1 Sys t em Requi rement s
There are two possible dongle upgrade scenarios:

■ TRADOS Translator’s Workbench 1.x Users. If you are using version 1.x, you will 
need a new dongle. Contact your local TRADOS office to obtain an upgrade.

■ TRADOS Translator’s Workbench 2.x Users. TRADOS T-Window for PowerPoint 
will run on the same dongle as TRADOS Translator’s Workbench. However, you 
must program your existing dongle so that it recognises TRADOS T-Window for 
PowerPoint.

Follow the instructions below to upgrade your dongle:

1 Launch TRADOS Translator’s Workbench. Select About from the Help menu. 
Licence information is displayed. Note this number: it is necessary for upgrading 
your dongle.

2 Send your licence number to your local TRADOS office via e-mail. You will 
receive an executable file, dongle.exe which will reprogram your existing 
dongle to recognise T-Window for PowerPoint. If you wish to upgrade more than 
one licence, contact your local TRADOS office for batch dongle upgrade 
procedures.

3 Exit Translator’s Workbench. Run the dongle.exe file. A DOS box opens and 
informs you that your dongle is being reprogrammed. When the process is 
complete check that your dongle has been upgraded. To do this, launch 
Translator’s Workbench and select About from the Help menu and ensure that 
1-4 T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T



1Syst em Requirements
TRADOS T-Window for PowerPoint has been added to the list of Further licensed 
products. 

DEMO MODE
When TRADOS T-Window for PowerPoint is running in demo mode, you can only translate small files 
containing no more than three slides.
T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T 1-5



1 Ins ta l l ing  TRADOS T-Window for  PowerPo in t
I N S T A L L I N G  T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T
If you have received a disk set, run the setup.exe. If you have downloaded the application from the 
TRADOS Web site, unzip the file and run the setup.exe.

➜
NOTE

Before you start translating, make sure that you have installed version 2.2 of TRADOS 
Translator’s Workbench. Also check that you have PowerPoint 97 installed.

Once you have installed TRADOS T-Window for PowerPoint, you are ready to begin translating. 

DIALOG LANGUAGE
You can select the dialog language of T-Window for PowerPoint by selecting the Dialog Language 
option from the Trados menu in PowerPoint. You can dynamically switch between English, French, 
German or Japanese.
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CHAPTER 2

T R A N S L A T I N G  W I T H  T - W I N D O W
T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T
This chapter will show you, using a brief

tutorial, how to get started with

translating your Microsoft PowerPoint

presentations using

TRADOS T-Window for PowerPoint.

The second part of the chapter describes the

interface between TRADOS Translator’s

Workbench and TRADOS T-Window for

PowerPoint. Some translation procedures

are presented.
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2 Tutoria l  -  Get t ing  Star ted
T U T O R I A L  -  G E T T I N G  S T A R T E D
Before starting this TRADOS T-Window for PowerPoint tutorial, you will need to have TRADOS 
Translator’s Workbench (version 2.2 or later) installed on your computer as well as TRADOS T-Window 
for PowerPoint, Microsoft PowerPoint 97 and MultiTerm ‘95 Plus!. MultiTerm ‘95 Plus! is the 
terminology database from TRADOS, which allows you quick access to all your terms. If it is not 
installed on your computer, you can still use TRADOS T-Window for PowerPoint, but you will not be 
able to avail of the powerful terminological benefits of MultiTerm.

Once you have installed the relevant applications, following the directions in the installation routines, 
you should launch the products in the following order:

1 MultiTerm ‘95 Plus!

2 TRADOS Translator’s Workbench

3 TRADOS T-Window for PowerPoint

➜
NOTE

You must start TRADOS Translator’s Workbench 2.2 before your first use of TRADOS T-Window 
for PowerPoint.

MULTITERM
Launch MultiTerm ‘95 Plus! and open the database guidemo.mtw which you will find in the directory 
into which you installed MultiTerm.

Choose Create Fuzzy Index from the File menu. This may take a few moments to complete. You will be 
alerted when the fuzzy index is created. If you do not create a fuzzy index, Translator’s Workbench will 
not automatically suggest terms from your MultiTerm glossary which appear in your text for translation.

TRADOS TRANSLATOR’S WORKBENCH
Open TRADOS Translator’s Workbench and open the sample translation memory twinsample.tmw 
which you will find in the samples directory in the directory into which you installed TRADOS 
T-Window for PowerPoint. In the View menu of TRADOS Translator’s Workbench, set the Zoom to 60%. 
If the Zoom remains at 100%, Translator’s Workbench will display the actual font size of the segment 
in its Source Window. The sample presentation contains segments in large font sizes. For optimum 
viewing of these segments, you should set your Translator’s Workbench Zoom to 60%.

TRADOS T-WINDOW FOR POWERPOINT 
Launching TRADOS T-Window for PowerPoint will also launch PowerPoint 97, unless PowerPoint is 
already open. When you work with TRADOS T-Window for PowerPoint, you work in Microsoft 
PowerPoint for all activities other than the actual translation of the segments and application of any 
formatting to the new translated segments.
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2Tutor ia l  -  Get t ing S tar ted
The only differences you will see between your normal installation of PowerPoint and PowerPoint with 
TRADOS T-Window for PowerPoint are the Flagman button  on the standard toolbar and the Trados 
menu in the menu bar. TRADOS T-Window for PowerPoint features can only be accessed when there is 
a PowerPoint presentation open.

➜
NOTE

The standard toolbar must be visible before you will see the TRADOS Flagman on your screen.

SAMPLE FILE
Open the sample file twinsample.ppt which you will find in the samples directory in the directory 
into which you installed TRADOS T-Window for PowerPoint. Save the file with a new name, into the 
directory of your choice.

➜
NOTE

The demo version of TRADOS T-Window for PowerPoint will only allow you to translate 
presentations which contain three slides or less. If you have an existing presentation that you 
wish to try out, open the presentation, choose Slide Sorter from the View menu, and copy three 
of the existing slides into a new presentation.
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2 Tutoria l  -  Get t ing  Star ted
ARRANGING THE WINDOWS
Arrange the TRADOS Translator’s Workbench window and the PowerPoint window so that you can see 
the source and target windows of TRADOS Translator’s Workbench at the same time as the PowerPoint 
presentation.
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2Tutor ia l  -  Get t ing S tar ted
TRANSLATION SEQUENCE
Before we start translating the sample slide, we should set our Translation Sequence. The Translation 
Sequence option allows you to choose in which order you wish to translate the various items within a 
PowerPoint presentation. We will choose to translate first a slide, followed by the notes on the Notes 
page for that slide.

Choose Translation Sequence from the Trados menu on the menu bar. A dialog box will appear, where 
you check the items you wish to translate and the sequence in which you wish to translate them.

Check the box beside the Slides/Notes option and click OK. TRADOS T-Window for PowerPoint will now 
start the translation sequence with the first slide and then continue to the Notes page for the first slide, 
if there is any text on the Notes page. The second slide will be presented for translation after the notes 
for the first slide.
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2 Star t ing To  Trans la te
S T A R T I N G  T O  T R A N S L A T E
To start translation of the PowerPoint slide, click on the Flagman button  on the standard toolbar, 
or choose Open/Get from the Trados menu. Clicking on the Flagman button is the same as selecting 
Open/Get from the Trados menu. You should choose Open/Get rather than just Open as this will ensure 
that the translation memory is searched for the first segment without further prompting.

Notice that the TRADOS T-Window for PowerPoint interface with TRADOS Translator’s Workbench is 
very similar to the TRADOS Translator’s Workbench interface when working with either Word or 
TagEditor. This familiar interface ensures that experienced TRADOS Translator’s Workbench users will 
transition smoothly and instantly feel at home. See the TRADOS T-Window for PowerPoint on-line help 
for a list of keyboard shortcuts for the Translator’s Workbench toolbar.

A certain amount of activity will then take place on your screen. This is TRADOS T-Window for 
PowerPoint re-arranging the windows to ensure maximum visibility. The translation window will then 
appear on your screen. If you are using the twinsample.ppt file and the twinsample.tmw along 
with the guidemo.mtw files for this tutorial, you will see that the translation window looks something 
similar to the illustration below:

The TRADOS Translator’s Workbench window should look something similar to the illustration below:

In the TRADOS Translator’s Workbench window, we can see that there are two parts to this segment, 
whereas in the T-Window we can only see the first part of the segment. To see both parts of the 
segment, we will do two things. First we will show the invisibles, so that we can see the non-breaking 
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2Star t ing  To  Trans la t e
carriage return symbol, and then we will change the percentage zoom so that the entire segment is 
presented in the T-Window.

SHOW ALL    
Click on the Show All button to reveal or hide non-printing characters. You will find it particularly useful 
when the source PowerPoint text contains tabs, manual line breaks or extra carriage returns. These are 
not visible in PowerPoint and are often used to achieve text manipulation which you may need to 
replicate in the translated text.

ZOOM
When you click on the Zoom button, a drop-down list appears from which you can choose the 
percentage size you wish to display the text in the T-Window at. We will choose 66%, and our 
T-Window will now look similar to the illustration below:

PERCENTAGE MATCH
On the bottom left of the T-Window you will see three buttons. These buttons display the percentage 
to which the segment which was found in the new source window matches a segment found in the 
translation memory. 

In this example, we can see that the match is 99%. If we look at our TRADOS Translator’s Workbench 
window, we will see that the status bar displays the text “Exact Match, -1% Formatting”. This tells us 
that the text is identical, but a penalty has been applied, because the formatting of the two segments 
is different. We can see that this is so, as the text in the source window is blue and the text in the target 
window is black.

We will wish to accept the translation, but we also wish to change the colour of the new segment from 
black to blue.
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C H A N G I N G  F O R M A T T I N G  A T T R I B U T E S
There are two ways in which we can change the colour of the new target segment. We can either select 
the text in the target window and apply the correct colour to it that way, or we can use the Format 
Painter to automatically apply the source’s formatting to the target.

TEXT COLOUR     
Select all the text in the target window and click on the Text Colour button. Clicking on the Text Colour 
button activates the palette of the colours you can apply to text in the target window.

Please note that the colours in the palette will always be the palette of colours already defined in the 
PowerPoint presentation you are editing. If you wish to use a colour not present in the palette, close 
T-Window and define the new colour in PowerPoint before returning to T-Window. You can then apply the 
new colour to the target segment.

FORMAT PAINTER   
The format painter allows you to replicate text attributes from the source segment to the target 
segment. This is the recommended way to apply formatting attributes from the source to the target 
text. To use the Format Painter:

1 Select some text in the source segment which contains the attribute(s) you wish 
to replicate.

2 Click on the Format Painter button.

3 Using the left mouse button, click and hold at the beginning of the text to which 
you wish to apply the attributes. Drag the mouse until you reach the point where 
you wish to stop applying the formatting. Release the mouse button.

The formatting of the source segment will now be applied to the text in the target segment.
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A C C E P T I N G  T H E  T R A N S L A T I O N
Now that we are happy with this translation, we will save the translation unit to the translation memory 
by clicking on the Set/Close button and proceed to the next segment by clicking on the Open/Get 
button. The Set/Close Next Open/Get command sends the formatted, translated segment to the 
translation memory database along with the source segment, for storage for future use, and goes 
forward in the presentation to the next segment. It then performs the Open/Get command on the new 
segment.

Click on the Set/Close Next Open/Get button . TRADOS T-Window for PowerPoint will move down 
through the slide and find the next segment for translation. 

A FUZZY MATCH
In our sample file, the next segment that TRADOS T-Window for PowerPoint finds is a Fuzzy Match. A 
Fuzzy Match is a segment in the translation memory which is similar but not identical to the source 
segment. Translator’s Workbench assigns a percentage value to the level of similarity between the 
source segment and the segment in the translation memory.

In this case, the Fuzzy Match is a 74% match. In the TRADOS Translator’s Workbench window, we can 
see which parts of the Fuzzy Match stored in the translation memory (TM) differ to the segment 
displayed in the source window. The words “Avail of” are in the segment stored in the translation 
memory, but not in the new source segment. 

We make the decision that the segment stored in the TM is the better one in this circumstance, and so 
we will accept the translation. However, since this translation will now be somewhat longer than the 
original source segment, we will first preview the translation in the PowerPoint file.

PREVIEW THE TRANSLATION
When the translation of a segment results in a new segment which is longer or shorter than the original 
sentence, you may wish to look at how the translated slide will be affected by the change in length.

To preview a translation, click on the Preview button on the toolbar . The Preview button allows you 
to check, for example, whether it would be desirable to change the point size or, perhaps, insert manual 
line breaks in order to achieve a better fit before updating the translation memory and moving on to 
another segment. 

You may need to move the T-Window around the screen a little bit, in order to view the slide. This will 
depend on the size of your screen.
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When you are satisfied that the length of the new translation, and any formatting you have applied, 
are correct, click the Set/Close Next Open/Get button.

SAVING THE PRESENTATION
Each time you click on the Set/Close or Set/Close Next Open/Get buttons in T-Window, you are saving 
the translated segment to the translation memory. You should also frequently save your presentation 
in PowerPoint. You can save your presentation from within T-Window by using the keyboard shortcut 
[Ctrl]+[S].

NOTES PAGES
When you select to translate Notes pages as well as slides by choosing Slides/Notes or checking the 
Notes option in the Translation Sequence dialog box, TRADOS T-Window for PowerPoint will move to 
the Notes page when all the elements on the slide that are translatable have been translated. If you 
have chosen Slides/Notes in the Translation Sequence dialog box, TRADOS T-Window for PowerPoint 
will present the Notes page after each slide if there is any translatable text on it.
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T E R M S  A N D  P L A C E A B L E S
In our example, there is text on the Notes page and TRADOS Translator’s Workbench has identified the 
segment as a 90% match. When you look at the TRADOS Translator’s Workbench window, you will see 
that the source window contains the new source segment, with some additional formatting applied to 
it aside from the yellow and grey shading which indicate the differences in the text between the source 
and target segments:

INSERTING TERMS
In this illustration, we see that the word “window” has a thick red overline. This line indicates that 
“window” is stored in the MultiTerm database as a Term. You can see the term and its translation in 
the Term window. If there was more than one identified term in the segment, the other terms would 
have a thinner red overline. The thick red overline indicates the Current Term. To place the Current Term 
in the target segment, click on the  Get Current Term button. You will see that TRADOS Translator’s 
Workbench has inserted the term in the target segment at the cursor position. If the source segment 
contains more than one term, you can place these terms in the target segment by clicking on the  
Get Previous Term or the  Get Next Term buttons depending on whether the other terms occur before 
or after the Current Term.

INSERTING PLACEABLES
We can also see from this illustration that the number “74%” has a thick blue underline applied to it. 
This indicates that the number is the Current Placeable. Placeables are items which TRADOS 
Translator’s Workbench has identified as non-translatable items but which must be “placed” in the 
target segment. Numbers, dates and hyperlinks are all recognised as being Placeables.

In our example. the previous translator has used the figures 100% in the translation instead of spelling 
out the numbers. We will use the same style, but need to replace the 100% with the 74%. We could 
just copy the numbers from the source window, but TRADOS T-Window for PowerPoint offers you a 
faster and more efficient method of doing this.

Select the text “100%” and click on the  Get Current Placeable button. You will see that TRADOS 
Translator’s Workbench has inserted the correct text in the target segment, replacing the original 
100%. The other buttons,  and  , activate the Get Previous Placeable and Get Next Placeable 
respectively. You would use the Get Previous Placeable and Get Next Placeable buttons if there was more than 
one placeable in the source segment.
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COMPLETING THE TUTORIAL
Click on the  Set/Close button to stop translating for the moment. You will be able to carry on where 
you left off by choosing Open at Last Edited from the Trados menu when you are ready to resume.

We have completed the tutorial section of this User Guide. You should now be able to continue 
translating the sample file using TRADOS T-Window for PowerPoint and TRADOS Translator’s 
Workbench with confidence. The rest of this chapter will give you an overview of the features of 
TRADOS T-Window for PowerPoint which we did not discuss during the tutorial. The User Guide for 
TRADOS Translator’s Workbench and the on-line help file will give you more information about the 
powerful tools available to you when you use TRADOS Translator’s Workbench, no matter what format 
the files you are translating are presented in. 
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I N T E R F A C E  W I T H  T R A N S L A T O R ’ S  W O R K B E N C H
The Workbench toolbar which acts as an interface between TRADOS T-Window for PowerPoint and 
TRADOS Translator’s Workbench is very similar to the interface between Word and TRADOS Translator’s 
Workbench. The traditional source and target edit fields are replaced by the T-Window. The interface 
is designed in this way so that experienced TRADOS Translator’s Workbench users will transition 
smoothly and instantly feel at home when they start using TRADOS T-Window for PowerPoint.

The table below lists each component of the Translator’s Workbench toolbar, along with a brief 
explanation of its function.

➜
NOTE

While the T-Window is active you cannot access the Translator’s Workbench functions except 
via the T-Window.

KEYBOARD SHORTCUTS

Icon Action Shortcut Explanation

Open/Get Alt+Num 7 Opens the current segment, searches for 
potential matches in the translation memory 
and transfers the translation — if any — to 
your document.

Restore Source Alt+Delete Undoes the last translation and restores the 
original source sentence. This is useful if you 
would like to get your source text back 
without having to enter a translation.

Copy Source Alt+Num 0 Copies the source sentence to the target 
field. This button is helpful if the target 
sentence is very much the same as the 
source sentence.

Set/Close Next Open/Get Alt+Num + Closes the currently open translation unit, 
saves it in the translation memory, opens 
the next sentence and transfers the 
translation — if any — to your document.

Translate to Fuzzy Alt+Num * Translates all 100% matches automatically, 
starting from the currently open translation 
unit, and stops at the next fuzzy match.

Set/Close Alt+Num 1 Closes the currently open translation unit, 
saves it in the translation memory, opens 
the next sentence and transfers the 
translation — if any — to your document.
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TRANSLATOR’S WORKBENCH TOOLBAR DIFFERENCES
There are some differences between the Translator’s Workbench toolbar as it appears in Word or 
TagEditor and the toolbar that appears in T-Window. Certain Word-specific aspects of the Word 
Workbench toolbar are not relevant to the T-Window for PowerPoint translation environment. For 
example, Tag Protection is not available for the simple reason that no tags are visible in the PowerPoint 
presentation, so there is no necessity to protect them. Nor is Shrink Segment functionality available in 
T-Window. The nature of PowerPoint translation segments is such that they tend to exist as self-
contained units, for example bulleted lists. While there may be a requirement to expand a segment 
where you wish to merge two points of a bulleted list in the translated text, there is no corresponding 
need for a shrink segment feature. Some features have been added in the T-Window Workbench 
toolbar, for example the Flagman button and the Preview button.

Flagman Button 

After you install T-Window for PowerPoint, the Flagman button is added to PowerPoint’s standard 
toolbar. Clicking on the Flagman button sets the translation process in motion. In addition to launching 
T-Window for PowerPoint it also activates the Open/Get procedure and presents the first text for 
translation in the target field of T-Window for PowerPoint.

Experienced Translator’s Workbench users will be familiar with the Flagman button in Word, where its 
functionality is slightly different. Clicking on the Flagman button in Word hides or displays the 
Translator’s Workbench toolbar.

Concordance Alt+Num 8 Searches the translation memory for 
selected text. If Translator's Workbench can 
find the same or similar text, it will open a 
Concordance window showing all matching 
translation units.

Get Previous Placeable Alt+Ctrl+Num 4 Copies the previous placeable to the target 
field at the cursor position.

Get Current Placeable Alt+Ctrl+Num 2 Copies the current placeable to the target field 
at the cursor position.

Get Next Placeable Alt+Ctrl+Num 6 Copies the next placeable to the target field at 
the cursor position.

Get Previous Term Alt+Num 4 Transfers the translation of the previous 
term from the MultiTerm database to the 
target field.

Get Current Term Alt+Num 2 Transfers the translation of the current term 
from the MultiTerm database to the target 
field.

Get Next Term Alt+Num 6 Transfers the translation of the next term 
from the MultiTerm database to the target 
field.

Icon Action Shortcut Explanation
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Preview Button 

The Translator’s Workbench toolbar in T-Window also includes a Preview button which allows the 
translator to preview a segment in PowerPoint before accepting it. For more information, see “Preview 
the Translation” on page 2-9.

Expand Segment

This command expands the current source segment by one sentence. During translation, you may 
decide to translate two source sentences with one target sentence. A segment cannot be expanded past 
a paragraph end marker (¶).

Activate the Expand Segment command by using the keyboard shortcut [Alt]+[Ctrl]+[Num 3].

➜
NOTE

There is no menu option or button for the Expand Segment command, it may only be activated 
by using the keyboard shortcut.

POWERPOINT TRADOS MENU
When you install TRADOS T-Window for PowerPoint, a Trados menu is added to the PowerPoint menu 
bar which contains the following items:

Menu Item Explanation

Open Opens the current sentence and searches for potential 
matches in translation memory.

Open/Get Opens the current segment, searches for potential matches 
in the translation memory and transfers the translation — if 
any — to your document.

Open at Last Edited Opens the segment after the one you last edited. See “Open 
at Last Edited” on page 2-16.

Translation Sequence Allows you to choose the order in which you translate the 
various items within a PowerPoint presentation. See 
“Translation Sequence” on page 2-5.

Presentation Statistics Scans the presentation and creates a statistics file which 
contains useful information about your presentation. 
See “Presentation Statistics” on page 3-2.

Extract Text Exports the translatable text from a presentation to a 
text file. See “Extract Text” on page 3-3.

Remove Source Segments Removes source segments from your presentation after 
translation. See “Post-Translation Processing” on page 3-6.
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Open at Last Edited

Open at Last Edited is found on the Trados menu in the PowerPoint menu bar. It opens the segment 
immediately after the one you last translated. When you choose Open/Get, T-Window for PowerPoint 
will open either the first segment in the order specified in the Translation Sequence or the text currently 
selected. Open at Last Edited means you do not have to scroll through all the slides you translated 
previously.

T-WINDOW FORMATTING TOOLBAR
The T-Window formatting toolbar includes many of the same items as appear on the PowerPoint 
formatting toolbar. It allows the translator to apply formatting to the translated segment from within 
the T-Window.

Most of the buttons found in the T-Window main toolbar offer the standard text formatting functions. 
There are some additional buttons which have slightly different functionality in T-Window.

Superscript/Subscript 

Clicking on the SuperScript SubScript button activates a settings dialog box:

Select the text you wish to format in the T-Window. Check the SuperScript or SubScript checkbox 
depending on whether you wish the text to appear as a superscript or a subscript. Use the Offset box 
to determine how far away from the previous text the superscript or subscript will appear.

Show All 

Click on this button to reveal non-printing characters. You will find it particularly useful when the 
source PowerPoint text contains tabs, manual line breaks or extra carriage returns. These are not visible 
in PowerPoint and are often used to make text fit into a space in a particular way. You may need to 
delete these items or replicate them.

Fuzzy-Match Information

These buttons replicate the fuzzy-match information and options displayed by Workbench and have the 
same functions.
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Display Colour

The Display Colour option allows you to change the background colour of the T-Window to optimally 
display the text segment for translation. For more information, see “Display Colour” on page 2-19.

T R A N S L A T I N G  T E X T  T Y P E S  U S I N G  T - W I N D O W
There are several different text types found in PowerPoint presentations. This section looks at some of 
the translation issues presented by these text types.

■ Regular text - Standard text format

■ Bulleted lists - Text found in bulleted lists

■ Text objects - Text found in WordArt or grouped text objects

■ Master Text - Text found on PowerPoint’s Master Slide

BULLETED LISTS
Most PowerPoint presentations will include a bulleted list. How text from bulleted lists appears in the 
T-Window’s target field depends on the way in which the PowerPoint presentation was authored. If the 
bullet was inserted using PowerPoint’s Bullet option on the Format menu, then only the text will appear 
in the target field. However, if the bullet was manually inserted, the bullet will form part of the target 
segment in T-Window.

TEXT OBJECTS
TRADOS T-Window for PowerPoint will process all text objects found in a PowerPoint presentation, 
including text in grouped objects and WordArt objects. Where a slide contains multiple text objects, 
T-Window presents the text object that appears on the top left side of the slide for translation first. 
When this has been translated, T-Window presents the text objects for translation in the order in which 
they occur on the slide from top left to bottom right.

Grouped objects are where one or more items have been combined so that you can work with them as 
if they were one single object. TRADOS T-Window for PowerPoint makes text stored in grouped objects 
available for translation.

WordArt objects are drawing objects which were created using the WordArt tool on the Drawing 
toolbar. Although PowerPoint does not treat them as text, TRADOS T-Window for PowerPoint presents 
any translatable text from WordArt objects for translation in the T-Window.
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To edit WordArt directly in PowerPoint, double-click on the WordArt object and the Edit WordArt Text 
dialog appears. You edit the text, format it if required and click OK.

T-Window does not present WordArt text for translation in the Edit WordArt Text dialog. Instead, the 
WordArt text appears in the T-Window.

In the example above, the text for translation “Word Art Objects” appears in the source field. You enter 
the translation in the target field. Click on Set/Close and you can view the WordArt object in your 
presentation.

TRANSLATING POWERPOINT MASTER TEXT
In PowerPoint, the Master slide contains text which appears on all slides, handout pages or notes 
pages. There are four Master views:

■ Slide Master - Contains the layout of all the main slides in a presentation. May 
contain text for translation.

■ Slide Title - Contains the layout for the title slide in a presentation. May contain 
text for translation.
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■ Handout Master - Contains the layout for slides when they are printed out as 
handouts. The Header and Date/Time Areas may contain text for translation.

■ Notes Master - Contains the layout for notes pages when presentations are 
printed out. The Header, Date, Footer and Number Areas may contain text for 
translation.

T-Window for PowerPoint presents all PowerPoint Master Text for translation. Simply select the order 
in which you wish to translate this text by selecting the Translation Sequence option from the Trados 
menu in PowerPoint.

➜
NOTE

Placeholder text which appears on the Master slide (for example, “Click to edit Master title 
style”) will not be presented for translation in T-Window.

NON-TRANSLATABLE OBJECTS
TRADOS T-Window for PowerPoint will not process graphics which contain text for translation. Where 
graphics contain text for translation, this text must be translated using an alternative method. 
Similarly, linked or OLE objects cannot be processed using TRADOS T-Window for PowerPoint. 

DISPLAY COLOUR
TRADOS T-Window allows you to change the background colour of the T-Window. Sometimes a text 
object will have a background colour which is the same as the text colour. T-Window presents the text 
with the object background colour by default. For example, an object’s background colour may be white 
and the text colour may be yellow. In this case, you will give the text a different background colour to 
be able to see it better. The Display Colour offers four choices of background against which to display 
the text. Select the display colour by clicking on one of the Display Colour buttons.
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The first Display Colour button displays the text for translation against the default colour background 
for the PowerPoint presentation. The second button displays the text against a black background. The 
third button displays the text against a grey background, as illustrated in the example above. The fourth 
button displays the text against a white background. The black, grey and white buttons always appear. 
The colour of the first button is determined by the default background in the PowerPoint presentation.

FONT MANAGEMENT
You can change the font typeface and size of the translated text by selecting a font and size from the 
fromatting toolbar in T-Window for PowerPoint. Only fonts already stored on your system are available 
for selection.

Missing Fonts

If you open a presentation and find that T-Window cannot open it because of missing fonts, you must 
do one of the following things:

■ Obtain the font from the person or place you obtained the presentation, or,

■ Change the font using the Replace Fonts feature in PowerPoint

To replace fonts in PowerPoint, follow the instructions below:

1 Select Replace Fonts from the Format menu in PowerPoint. The Replace Fonts 
dialog appears.

The Replace drop-down list shows a list of fonts contained in the presentation. 
Any fonts that are missing are preceded by a question mark. The With drop-
down list contains a list of all the fonts on your system.

2 To replace a missing font, select the font you wish to replace from the Replace 
drop-down list with a font on your system which you select from the With drop-
down list. In this case, Gill Sans is being replaced with Arial.

SPELL-CHECKING
The current version of T-Window for PowerPoint does not include interactive spell-checking. To check 
the spelling in your presentation during translation, carry out the following steps:

1 Exit T-Window and save your presentation.
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2 Select Language from the Tools menu in PowerPoint. Select the language into 
which you are translating from the list in the Language dialog. Click on the 
Default button.

■ Select Autocorrect from the Tools menu in PowerPoint. Customise the settings to 
suit your text. Ensure that any spelling errors that PowerPoint detects are 
displayed. Select Options from the Tools menu in PowerPoint. Go to the Spelling 
tab and ensure that the Hide Spelling Errors check box is not checked. Any text 
containing spelling errors in your presentation should now appear with a wavy 
red line underneath it. 

To correct spelling errors and update your translation memory click on some text with a wavy red line. 
Click on the Flagman icon or select Open/Get to open the segment in the T-Window. Correct the spelling 
error and click on Set/Close. The spelling error has now been corrected and the translation memory has 
been updated. Repeat this process until all spelling errors have been corrected.

➜
NOTE

It is important that you carry out this process. Otherwise the translation memory will contain 
spelling errors.

➜
NOTE

The update translation memory option available in the Word and Translator’s Workbench 
interface is not available in T-Window, due to differences in how Word and PowerPoint 
function.
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T I P S  A N D  T R I C K S  F O R  T R A N S L A T I O N
This section includes some basic tips and tricks for translation.

COPY SOURCE
Use the Copy Source on No Match option from Translator’s Workbench so that when no match is found 
in the translation memory the source segment is automatically copied to the target field. The translator 
then simply overwrites the text in the target field. To activate Copy Source on No Match select 
Translation Memory Options from the Options menu in Translator’s Workbench. Go to the General tab 
and check the Copy Source on No Match checkbox. See the Translator’s Workbench User Guide for more 
information on Translation Memory options.

TRANSLATOR’S WORKBENCH FORMATTING PENALTIES
Formatting is a key feature of PowerPoint presentations. It is extremely important that all formatting 
is rendered correctly in the translated presentation. T-Window’s formatting features allow you to 
preserve all of the original PowerPoint presentation features. In addition, you may wish to set higher 
Translator’s Workbench translation penalties when translating PowerPoint presentations than when 
translating Word documents or tagged text documents. See the Translator’s Workbench User Guide for 
more information on setting translation penalties.

POWERPOINT FORMATTING
Sometimes PowerPoint formatting can cause problems for displaying segments for translation in 
T-Window. For example, if tabs have been used to make text fit better in a text box in PowerPoint, the 
segment will be broken up by tabs when it appears in the T-Window which would reduce the likelihood 
of an identical match being found in the translation memory.

In the case of the example this example, a tab has been inserted between the text “Background 
colours” and “display options”. Clicking on the Show All button in the T-Window formatting toolbar 
will display all invisibles like tabs and hard returns. If you are translating presentations into many 
different languages, you should clean up the presentations prior to commencing translation. See 
“Presentation clean up before translation” on page 3-5.
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REVISING TRANSLATED SEGMENTS
Once you translate a segment in T-Window, the translation memory is updated with the new translated 
segment and a copy of both the source and target segment is retained in the PowerPoint presentation. 
The source segment text remains invisible and the target segment text is displayed in the presentation. 
If you wish to change some target text in the presentation, you should always do this using T-Window.

1 In PowerPoint, place your cursor in the text segment you wish to change. 
Activate T-Window for PowerPoint. Open the segment in T-Window using the 
Open/Get command by either clicking on the Flagman button or by selecting 
Open/Get from the Trados menu in PowerPoint.

2 Edit the translated text in the T-Window target field as required. Save the 
translated segment to the translation memory by clicking on the Set/Close 
button. If you wish to proceed and edit the next segment, click on the Set/Close 
Next Open/Get button.

3 Save your PowerPoint presentation using the keyboard shortcut [Ctrl]+[S].

REMOVE SOURCE SEGMENTS
During translation, both source and target text information is stored in the PowerPoint presentation. 
This enables you to make changes to translated text using T-Window. Although this information is 
invisible, it increases the size of the PowerPoint presentation. Once translation is complete and all 
changes have been implemented in the translation memory, you should remove the source segments. 
For more information, see “Post-Translation Processing” on page 3-6.
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T R A N S L A T I O N  W O R K F L O W
The translation workflow for T-Window for PowerPoint depends on many factors. For example, the 
number of languages into which you are translating and the size and complexity of the PowerPoint 
presentations. One possible workflow follows. You may wish to tailor the workflow to suit your own 
requirements. The workflow consists of three stages:

■ Stage 1: Evaluation - assessing the translation work to be done

■ Stage 2: Translation - translating the PowerPoint text

■ Stage 3: Post-Translation Processing - removing source segments

Each of these stages will be examined in detail.

EVALUATION 
Before you begin translating, it is useful to quantify the amount of work that has to be done and exactly 
what is required to complete the task. T-Window for PowerPoint provides several features which aid 
you in this process. The Presentation Statistics feature tells you what types of text are found in your 
presentation. This allows you to choose the most efficient way of translating them. The Extract Text 
feature allows you to export the text from your presentation into a text file which is suitable for analysis 
using the TRADOS Translator’s Workbench Analyse feature.

Presentation Statistics

Presentation Statistics quickly scans the presentation and creates a statistics file which contains useful 
information about your presentation. This statistics file is placed in the same directory as your 
presentation. It will have the same base name as your presentation with the extension 
.ppt-TTWin.txt. Follow the instructions below to obtain statistics on your presentation.

1 Open your PowerPoint presentation. Launch T-Window.

2 Select Presentation Statistics from the Trados menu in PowerPoint. A progress 
indicator appears briefly on your screen.

3 T-Window has created a statistics file in the same directory as your presentation.
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4 Open the statistics file in Notepad or another text editor.

The text file contains the following information: the name of the presentation, the number of slides, 
the total word count for translation, a list of the fonts used in the presentation file and a list of external 
objects in the file.

Once you have obtained the presentation statistics, you may wish to carry out the following 
preparation:

■ Ensure that you have all the fonts installed on the computer on which you will 
be carrying out the translation.

■ Assess if there is any text for translation in the external objects. T-Window for 
PowerPoint does not present any text contained in external objects for 
translation.

Extract Text

You may wish to analyse the text in the PowerPoint presentation against an existing translation 
memory to assess how much leveraging can be achieved. The PowerPoint file format .ppt is not one 
of the formats recognised by the Translator’s Workbench Analyse feature. T-Window’s Extract Text 
command exports the translatable text from a PowerPoint presentation to a text file which can be 
analysed against a translation memory.
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1 Select Extract Text from the Trados menu in PowerPoint. A progress indicator 
appears briefly on your screen.

2 T-Window for PowerPoint creates a text only file which contains all the available 
text for translation. The file has the same base name as your presentation with 
the extension.txt.

3 Open the text only file in Word or Notepad. 

4 If you wish to analyse the text against an existing translation memory, open the 
text-only file in Word, save it out as .rtf and run TRADOS Translator’s 
Workbench Analyse feature.

✤
TIP

Compare the text contained in the text-only file against a hard copy printout of your PowerPoint 
presentation. Text not found in the text-only file is not PowerPoint text and therefore is not available 
for translation in T-Window. Use the file to assess where hard returns or tabs will split the translation 
segment. Use this information to clean up your PowerPoint presentation before starting translation.
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Word Counts

Different applications have different methods of counting words. As a result, you will rarely find two 
separate applications generating the identical word count for the same text or document. This also 
applies to T-Window. The total word count in a presentation generated by T-Window’s Presentation 
Statistics command may differ slightly from the word count from the Translator’s Workbench analysis 
of the text file generated using Extract Text. Word counts carried out using Word would also yield 
different results. However, the word counts should not differ by a large percentage. Select the word 
counting utility that fits your own translation process.

Fonts

Before starting to translate, ensure that all the fonts contained in the presentation for translation are 
correctly installed on your computer. Sometimes the language into which you are translating may 
contain characters that are not supported by the original font in the source presentation. Where this 
occurs, use the T-Window formatting toolbar to apply the correct font to the target text. T-Window will 
always apply the default formatting from the source text to the target text.

Presentation clean up before translation

Before sending your presentation out for translation, scroll through it and look for formatting which 
may cause problems during translation.

Examples of this type of formatting are:

■ Tabs used instead of indenting text

■ Many cosmetic hard returns which split translation units

It is a good idea to clean up your presentation before sending them to translation. Taking these steps 
in the source language presentation will mean that each translator will not have to carry out the same 
task for each language into which the presentation is being translated.

TRANSLATION
The translation phase of the T-Window workflow has already been examined in detail in Chapter 2. The 
following list contains some of the steps which form part of the translation workflow.

■ Saving. The translator should save their presentation frequently. See “Saving the 
Presentation” on page 2-10.

■ Spell-checking. Once the translation phase is complete, the translator should 
spell-check the translated presentation. See “Spell-checking” on page 2-20.

■ Revising translated segments. Where changes need to be made to the translated 
presentation, they should be made using T-Window. See “Revising Translated 
Segments” on page 2-23.
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POST-TRANSLATION PROCESSING
During translatio,n both source and target text information is stored in the PowerPoint presentation. 
This enables you to make changes to translated text using T-Window. Although this information is 
invisible, it increases the size of the PowerPoint presentation. Once translation is complete and all 
changes have been implemented in the translation memory, you are ready to remove the source 
segments.

1 Exit the T-Window. Select Remove Source Segments from the Trados menu in 
PowerPoint. A warning message appears.

2 If you are sure that you do not wish to make any further changes to the 
translated presentation, click Yes. A progress bar appears briefly on your screen. 

Now all source segments have been removed from your presentation.

WARNING!
!!

Removing source segments from your presentation cannot be undone. Make sure that you are 
satisfied that your translation is complete before running the Remove Source Segments command.
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T R O U B L E S H O O T I N G
While using T-Window for PowerPoint, you may run into a some issues. The following section will help 
you deal with problems quickly and efficiently.

NO ACTIVE PRESENTATION
There is no presentation open. You must open a presentation before you will be able to start translation 
using T-Window.

NO ACTIVE TRANSLATION MEMORY
There is no translation memory open. You must open a translation memory in Translator’s Workbench 
before attempting to start translation in T-Window.

PROCESSING SPEED
When you are running MultiTerm ’95 Plus! in conjunction with T-Window for PowerPoint, the 
translation sequence and screen refresh may be less than optimal.

MISSING FONTS
If you do not have all the fonts contained in a presentation on your machine, T-Window will not be able 
to present any text for translation. For more information, see “Missing Fonts” on page 2-7.

SEGMENT NOT FULLY DISPLAYED
T-Window only displays part of the text for translation. Adjust the font display size using T-Window’s 
Zoom button on the T-Window formatting toolbar. By setting the Zoom to a lower percentage, 
T-Window will display the entire segment.

ENTIRE SLIDE NOT DISPLAYED
Not all of the slide is displayed in PowerPoint. Adjust the PowerPoint Zoom to display the whole slide 
on screen. To set the Zoom in PowerPoint, either select Zoom from the View menu or select the zoom 
percentage from the drop-down zoom percentage list in the standard toolbar.

OLE SYMBOL
The first time you open a segment in T-Window, the source segment displays in the Translator’s 
Workbench Source Window preceded by an OLE symbol. Exit T-Window and re-open the segment. You 
will now find that the OLE symbol has been replaced by the familiar T-Window icon.

COLOUR DISPLAY IN TRANSLATOR’S WORKBENCH
The colours displayed in the Translator’s Workbench Source and Target Window are different to the 
colours displayed in T-Window for PowerPoint. This will happen, sometimes, because Translator’s 
Workbench uses only 16 colours, whereas PowerPoint can display thousands.
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TRANSLATION MEMORY 
TERMINOLOGY

If you are an experienced Translator’s 
Workbench user, most of the terminology in this 
User Guide will already be familiar to you. 
However, if you are new to TRADOS Translator’s 
Workbench and the other fine translation tools 
from TRADOS, you will find this terminology list 
helpful. For a full explanation of all Translator’s 
Workbench terminology, please refer to the 
documentation shipped with TRADOS 
Translator’s Workbench.

100% MATCH
A 100% match represents an exact match 
between the current segment (the new segment 
in the source window) and at least one other 
segment stored in the translation memory (TM). 

CLOSE
Closes the currently open translation unit 
without saving the translation in translation 
memory and ends translation mode. This is 
useful if you would like not to save your current 
translation to TM. If the target field is empty, 
Translator's Workbench will restore your original 
source text in the same way as Restore Source.

CONCORDANCE
After selecting a word or other sentence part in 
your word processor, use the Concordance 
command to search the translation memory for 
the selected text. If Translator's Workbench can 
find the same or similar text, it will open a 
Concordance window showing all matching 
translation units.

COPY SOURCE
Copies the source sentence to the target field. 
This button is helpful if the target sentence is 
very much the same as the source sentence.

EXPAND SEGMENT 
Expands the current source segment by one 
sentence. During translation, you may decide to 
translate two source sentences with one target 
sentence. This is what the Expand Segment 
command is there for. A segment cannot be 
expanded past a paragraph end marker (¶). In 
this case, a beep sounds and Translator's 
Workbench displays the message “Cannot resize 
segment”.

After resizing the segment, you may want to 
search the translation memory for a potential 
match. To do this, press the shortcut [Ctrl] + [Alt] 
+ [·]. If Translator's Workbench can find a match, 
it will transfer the target segment to the 
Translation Window.

FUZZY MATCH
A fuzzy match is where the TM has found a 
segment in its database which is similar but not 
identical to the current segment. You can set the 
percentage of fuzzy matching yourself. A 
segment stored in the TM may match the new 
segment exactly, except for the formatting. In 
that case, a formatting penalty would be applied 
and the 100% match would become a fuzzy 
match.

C

EE

F

T R A D O S  T - W I N D O W  F O R  P O W E R P O I N T G-1



G Glossary
GET CURRENT PLACEABLE
Copies the current placeable (tag, graphic, field, 
hyperlink or other non-translatable element) to 
the target field at the cursor position. You 
recognise the current placeable element by the 
bold blue bracketed underlining.

GET CURRENT TERM
Transfers the translation of the currently 
highlighted term (bold red bracketed line) to the 
target field.

GET NEXT PLACEABLE
Copies the next placeable (tag, graphic, field, 
hyperlink or other non-translatable element) to 
the target field at the cursor position. You 
recognise placeable elements by a blue 
bracketed underlining.

GET NEXT TERM
Transfers the translation of the next term to the 
target field.

GET PREVIOUS PLACEABLE
Copies the previous placeable (tag, graphic, 
field, hyperlink or other non-translatable 
element) to the target field at the cursor 
position. You recognise placeable elements by a 
blue bracketed underlining.

GET PREVIOUS TERM
Transfers the translation of the previous term 
from the MultiTerm database to the target field.

GET TRANSLATION
Transfers the translation currently displayed in 
Workbench’s Translation Memory window to 
your document. This is useful if you would like to 
transfer a fuzzy match other than the one initially 
suggested by the Open/Get function.

OPEN (IN TRADOS MENU OR TOOLBAR)
Opens the current sentence and searches for 
potential matches in translation memory. When 
you are using Translator’s Workbench, the term 
Open refers to the translation unit rather than 
the translation memory.

OPEN/GET
Opens the current segment, searches for 
potential matches in the translation memory and 
transfers the translation — if any — to your 
document. This refers to the command Open 
Translation Unit and Get Best Match From 
Translation Memory. 

PLACEABLE
A placeable refers to a part of a segment which 
has been identified as a non-text item, for 
example, a number or a hyperlink. It does not 
require translation, but it must be ‘placed’ in the 
correct location in the target segment.

RESTORE SOURCE 
Undoes the last translation and restores the 
original source sentence. This is useful if you 
would like to get your source text back without 
having to enter a translation.

SEGMENT
A segment is a piece of text which in itself 
represents a logical unit. A segment is most 
often a sentence, but can also be another part of 
speech or a heading.
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SET/CLOSE
Closes the currently open translation unit, saves 
it in translation memory, opens the next 
sentence and transfers the translation — if any 
— to your document. This command will also 
close the translation window.

SET/CLOSE NEXT OPEN/GET
This command means that you wish to confirm 
the translation and move on to the next 
sentence. It closes the currently open translation 
unit, saves it in the translation memory, opens 
the next sentence and transfers the translation 
— if any — to your document.

SOURCE
Refers to the original language segment or the 
source language window.

TARGET
Refers to the language the text is being 
translated into. 

TRANSLATION UNIT
Refers to a segment and its corresponding 
translation as they occur in the TM database.

TRANSLATE TO FUZZY 
Translates all 100% matches automatically, 
starting from the currently open translation unit, 
and stops at the next fuzzy match.
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Bulleted lists 2-17

Buttons
concordance 2-14
copy source 2-13
display colour 2-17, 2-19–2-20
flagman 2-3, 2-6, 2-14
format painter 2-8
formatting toolbar (T-Window) 2-16
get current placeable 2-11, 2-14
get current term 2-11, 2-14
get next placeable 2-11, 2-14
get next term 2-11, 2-14
get previous placeable 2-11, 2-14
get previous term 2-11, 2-14
keyboard shortcuts 2-13–2-14
open/get 2-13
percentage match 2-7
preview 2-15
restore source 2-13
set/close 2-9, 2-10, 2-13, 2-23
set/close next open/get 2-9, 2-10, 2-13
show all 2-7, 2-16, 2-22
subscript 2-16
superscript 2-16
text colour 2-8
translate to fuzzy 2-13
zoom 2-7, 3-7

Carriage returns
viewing 2-7, 2-16

Colour
about 2-8
changing background 2-17, 2-19–2-20
Translator’s Workbench Window 3-7

Commands See Trados menu

Concordance window 2-14

Copy protection See Dongle

Copy source 2-22

Dates 2-11

Demo mode 1-3, 1-5, 2-3

Dialog language 1-6

Dongle 1-3
executable file 1-4
upgrade 1-3–1-5

Eastern European languages 1-3

Editing translated segments 2-23

Expand Segment command 2-15
keyboard shortcut 2-15

Exporting text 2-15, 3-2, 3-3–3-4

External objects 3-3

Fonts
changing 2-20, 3-5
display size 3-7
missing 2-20

Format Painter 2-8

Formatting
applying 2-8
changing 2-8, 2-16
clean-up before translation 2-22, 3-5
default applied 3-5
hard returns 3-5
potential problems of PowerPoint 2-22
replicating 2-8
setting penalties in Translator’s Workbench 2-22
tabs 2-22, 3-5
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Formatting toolbar 2-16, 3-5

Fuzzy index 2-2

Fuzzy match 2-9, 2-16

Graphics with text 2-19

Grouped objects 2-17

Hard returns 3-5

Hyperlinks 2-11

Installation 1-6, 2-2

Interface of T-Window
with PowerPoint 2-2, 2-15
with Translator’s Workbench 2-2, 2-6, 2-13–2-15

Invisibles See Non-printing characters

Japanese
as dialog language 1-6

Keyboard shortcuts 2-13–2-14

Languages supported 1-3

Master slide
placeholder text 2-19

translating Master text 2-18–2-19
translation order 2-19

Microsoft PowerPoint See PowerPoint

MultiTerm ‘95 Plus! 2-2, 2-11, 3-7

Non-printing characters 2-7, 2-16

Non-translatable items 2-11

Non-translatable objects 2-19

Notes pages 2-10
translating 2-10–2-11

Numbers 2-11

OLE objects 2-19

OLE symbol 3-7

Palette, colour 2-8
creating new colour 2-8

Percentage match 2-7

Placeables 2-11
keyboard shortcuts 2-14

Placeholder text 2-19

Platforms supported 1-3
See also System requirements

PowerPoint 1-2
interface with T-Window 2-2–2-3, 2-15
launching of 2-2
menu bar modification 2-3, 2-15
standard toolbar modification 2-3, 2-14
version supported 1-3
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PowerPoint presentations See Translating presentations

PPT See PowerPoint

Preparing presentations 3-4, 3-5

Previewing 2-9, 2-15

Processing speed 3-7

Removing source segments 2-23, 3-6

Saving
in PowerPoint 2-10
in T-Window 2-10
keyboard shortcuts 2-10, 2-13

Screen refresh 3-7

Security key See Dongle

Shrink Segment 2-14

Size
of segment in translator’s workbench 2-2
of text in T-Window 2-7, 3-7

Slides
Master text in 2-18
text types 2-17
translating 2-5–2-10
Translation Sequence 2-5
working in demo mode 1-5, 2-3

Source segments, removing 2-23, 3-6

Spell-checking 2-20–2-21

Statistics of presentation 2-15, 3-2–3-3
analysing statistics file 3-3
creating statistics file 3-2

System requirements 1-3

Tabs 2-22, 3-5

Tag Protection 2-14

Target segments, editing 2-23

Terminology database 2-2, 2-11

Terms 2-11
keyboard shortcuts 2-14

Text attributes
colour 2-8
fonts 2-20
See also Formatting

Text objects 2-17–2-18
translation order in multiple 2-17

Text types
bulleted lists, text in 2-17
Master slide, text on 2-17
text objects 2-17

Text, exporting 2-15, 3-2, 3-3–3-4

TM See Translation memory

Toolbars in T-Window
formatting toolbar 2-16
Translator’s Workbench toolbar 2-13–2-15

Trados menu 2-15
extract text 2-15, 3-2, 3-3–3-4
open 2-6, 2-15
open at last edited 2-15
open/get 2-6, 2-15
presentation statistics 2-15, 3-2
remove source segments 2-15, 3-6
translation sequence 2-15

TRADOS Web site
products from 1-2, 1-3

Translatable text
extracting from PowerPoint 3-3–3-4

Translating presentations
accepting translation 2-9
bulleted lists, text in 2-17
clean-up before translation 2-22, 3-5
copying source segments 2-22
editing translated segments 2-23
exporting text 3-3
launching the products 2-2
Master text 2-18–2-19
notes pages 2-10–2-11
optimum viewing 2-2, 3-7
overview 2-6–2-12
previewing 2-9, 2-15
removing source segments 2-23, 3-6
resuming translation 2-12, 2-16
saving 2-10
setting up for 2-2–2-5
slides 2-6–2-10
text objects 2-17–2-18
translation sequence 2-5

Translation memory
analyse feature (Translator’s Workbench) 3-3
copy source to target 2-22
database 1-2, 2-9
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formatting effects on 2-22
fuzzy match 2-9
leveraging from 3-3
percentage match 2-7, 2-9
saving to 2-9, 2-23
searching in 2-6
technology 1-2

Translation Sequence 2-5, 2-10, 2-15, 2-19, 3-7

Translator’s Workbench 1-2
analyse feature 3-3–3-4
formatting penalties 2-22
interface with T-Window 2-6, 2-13–2-15
interface with Word 2-13, 2-14
toolbar in T-Window 2-13–2-15
translation memory options 2-22
versions 1-3, 1-4
zoom setting 2-2

Troubleshooting
entire slide not displayed
missing fonts 3-7
no active presentation 3-7
no active presentation memory 3-7
OLE symbol 3-7
processing speed 3-7
segment not fully displayed 3-7

Tutorial 2-2–2-12

User profile 1-2

Viewing 3-7
See also Buttons, Zoom

Windows versions 1-3

Windows, source and target
arranging 2-4

Word counts 3-5

WordArt objects 2-17–2-18

Workflow, Translation
evaluation 3-2–3-5
post-translation processing 3-6

translation 3-5
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